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Lesson 1: Altering the look of text boxes 

Changing the shape of an existing text box 

You can also change the shape of the text boxes if desired.  Click on the 

edge of the relevant shape so that it has “handles” around it as shown 

right 
 

Click the Drawing tools   tab, and click  in the Insert shapes group. 

Click to see a submenu of shapes.  Click to select a shape. 

 You must also change the text box so it so that it has a border colour. (see Changing the border 

colour below)  

Inserting new Text boxes with different shapes 

Click the Insert tab, click the Shapes icon (shown right) and click the desired shape. 

Now move your cursor onto the slide and click where you wish the top left corner of the 

shape to be, hold the left mouse button down and drag to the bottom right corner of the  

shape.  Release the mouse button.   You can now enter text.  A text box inserted in this way will 

automatically have a border and a fill colour. 

Don’t forget to make sure that the AutoShape has a line around it. 

Note: If you add text into a new Text box that text will not be shown in the Outline.  Only text in 

the standard Text box is included in the Outline. 

Changing the shape of the shape! 

Many shapes will have a small diamond somewhere on the edge when selected (some shapes have 

more than one!).  Click and drag on the triangle to alter the shape. 

 

e.g. in the example shown left we can drag the diamond to the 

right to change the size of the central box area. 

 

Changing the border colour 

Select the shape, click the Drawing tools   tab - you see  

Click  to use the colour shown under the pencil, or click  to choose another colour 

Note that you can also use  to alter the appearance of the text box.  

Changing the fill colour 

Select the shape, click the Drawing tools   tab and you see   

Click  to use the colour shown under the paint pot, or click  to choose another colour. 

Using the shape style Gallery 

Select the shape, click the Drawing tools   tab and in the shape 

tools group view the area shown right.  Click  to see more options.  

Changing the default border, fill colour and effect 

Select an existing textbox and change the outline and fill to those you want to use as defaults.   

Right click the text box and select .  Any future text boxes (of any shape) will have 

the border and fill that you defined 
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Lesson 2: Working with Themes  

What is a Theme? 

A theme is a general look, incorporating text colour, background etc, and also layouts for different 

kinds of slides 

Applying a theme 

To all slides 

Click the Design tab, and look at the Theme gallery. Click  to see more themes. 

 

Rest your cursor over a theme and your slides will temporarily change to give you a preview of 

what that theme will look like. Click when you are ready to apply a theme. 

The theme is applied to all slides in the presentation by default 

To selected slides 

Select the slides and right click the desired theme.  Click  

Changing the theme for all slides based on a theme 

If you have formatted several slides using a theme and you wish to change the theme for those 

slides , first select one of the slides, then right click the desired theme and select  

Changing the default theme 

If you want all new presentations to use a theme, right click the desired theme and click 
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Lesson 3: Working with Theme colours 

What are theme colours? 

Theme colours consist of a basis palette of eight colours.  Each of the eight defines the colour of 

one item.  E.g.  background, text, accents, and hyperlinks.  You choose an appearance of the slides 

with a theme, but you can vary the look of the theme by changing the theme colours.  It is possible 

to apply one set of theme colours to one slide and another to a different slide. 

Applying a different theme colour set 

To all slides 

Rest over a colour set to see a preview of how it affects your slides.  Click the desired colour set to 

apply it to all slides 

To selected slides 

Select the slide, or slides. Click the Design tab and click . Right click the desired colour 

set and click  

Creating a new colour set  

Click the Design tab and click .  Click . You can then click  

for each option to change the colour.   

Click in the Name box and enter a name for your colour set e.g.  

The new colour set will show at the top of the list of theme colours, under Custom 

Deleting a theme colour set 

You can only delete the theme colour sets in the Custom group. 

Click the Design tab and click .  Right click the theme colour set you want to delete and 

click  
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Lesson 4: Changing the Slide Background – Solid Fill 

The slid fill option will give a background of a single even colour. 

To change the background for all slides change to View the Slide Master, otherwise select the 

relevant slide or slides. 

Click the Design tab and click  to the right of the Background group title. 

Click the  at the right of the box underneath 

Background fill 

(Note – depending on the theme used these will affect all 

or part of the slide) 

Click  

Colour 

Click  to select the colour.  Note that you can choose from Theme 

colours or standard colours, but if none of these show the colour you 

want you can click  to see a full spectrum of colours. If even 

this is not enough for you, click the  tab to create your own 

colour. 

Transparency 

You can also alter the transparency to change the solidity of the colour.  

   

The background will change immediately as you alter this, so you can see how it looks.  0% means 

that the picture will be full colour and strong.  100% will probably meant that the picture is so faint 

that it is invisible, or nearly so. 

Hide background graphics 

If the slide master has objects that you have put there, e.g. a logo that appears on every slide, you 

can choose not to show that object on a slide, maybe because you want to use that space on this 

slide. Click to select  

Note this will not affect items which are part of a theme. 

Reset Background 

Click  to set the background back to that defined by the theme you chose for the slide 

Close the dialogue box 

Click  to apply the changes you have made to the selected slide(s) 

Apply to All 

Click  to apply the changes you have made to all slides in the presentation 
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Lesson 5: Changing the Slide Background – Gradient Fill 

This allows you to set up shading across the background using 

up to 10 colours.  

To change the background for all slides change to View the 

Slide Master, otherwise select the relevant slide or slides 

Click the Design tab and click  to the right of the Background 

group title. 

Click to select  

Preset Colours 

Click  to select from preset shading options.  You can alter 

these using the options below if you choose to do so. 

Type 

Use this to change the type of the shading changes.    

Linear  there are straight lines of shading across the slide 

Radial the shading areas are curves rather than straight lines 

Rectangular the shading areas are L shaped 

Path the shaded areas form a square 

Shade from title  the shaded areas form a square, with the centre colour around 

the tile text box 

 

Direction 

This only applies to Linear, Radial and Rectangular, and allows you to alter which side the 

colouring starts from, and which direction the shading goes across the slide 

Angle 

This applies only to Linear and allows you to define the angle at which the lines cross the slide 

Gradient Stops 

 The gradient stops define the start, end or middle of a colour in 

the shading.  Select the stop from the  box, and then 

make the necessary changes for that stop. The options below 

must be set for each Stop 

Add  

Click  to add a new stop. This has the effect of copying the currently selected stop details 

to a new stop following that one.  i.e. you will have two identical stops following one another. 

You can have up to 10 stops 

The options below must be set for each Stop 

Remove 

Click  to delete the currently selected stop 

Stop Position 

This defines the point at which the colour chosen begins to shade into the next colour.  You can 

either use the slide, or type in a percentage.   
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The further apart stops are the more gradual the shading is.  The first stop (Stop 1) will always be at 

0% and the last at 100%.  There is no real hard and fast rules as to precisely what happens with the 

stops in between, you may have to play with the percentages to get the effect you require. 

Colour 

Use the  to select the colour for the defined stop.  Note that you can use more colours 

as before. 

Transparency 

Either use the slide, or type a number in.   

A transparency of 0 will show the colour at its full strength, while 100 will not show the colour at 

all.  You can use this to lighten the effect of a colour  

Notes: 

1. The  option is greyed out because it is only relevant when you apply 

background gradients to a shape. (select the shape and on the Drawing tools, Format tab click 

 , , , ) 

2. If you have created a gradient that will be the default gradient until you close and reopen 

PowerPoint. (The standard default is a 3 stop gradient based on Accent 1 of the Theme colour 

set) 
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Lesson 6: Changing the Slide Background – Picture 

Picture or texture fill 

Texture 

Choose background textures from  

Picture 

You can use a picture, photo etc as a background by selecting it using 

.   You can also find a picture you like, select it and copy it 

to the clipboard, and then click  to paste it as a background.  

Use a Clip Art by clicking   

Tiling 

Selecting will repeat the picture you chose in 

small tiles over the slide.  
If not selected there will be one picture, or one piece of texture, filling the screen.  

If you chose to tile you can change the options below. 

Offset  

Offset refers to the positioning of the picture, or tiles, on the slide. The offsets allow you to position 

the picture on the slide.    

Offset X deals with the position from the left, while Offset Y deals with the position from the Top.   

In the examples shown right, Durers hands have been tiled on 

the screen. On the left the offsets are 0, on the right the Offset 

Y has been altered to -124 points – to take it up so the bottom 

of the picture is shown 

Scale 
    

Use this to change the size of the picture.  Scale X refers to the width and scale Y the height. 

In the example shown right the Durer hands Scale X (the width) has been 

scaled to 77% so that two full sets of hands appear 

You can scale both X and Y to fit more repeats, e.g. Scale x is 

now 50% and Scale Y 47% 

Alignment  

You can use alignment to position the picture on the slide 

Mirror Type 

This will turn alternate pictures horizontally, vertically or both.  The example 

shown right is set to horizontal 

Transparency 

This allows the “fading” of pictures so that writing place over the top can show up 

well. 0% transparency shows the picture at full strength, while 100% is complete 

transparency, i.e. you will probably not see the picture at all.  In the example shown 

right the transparency is 75% 

NOTE: The rotate with shape option is only available when you are applying the background to a 

shape – do this by first selecting the shape, then from the Drawing Tools, Format ribbon click 

, click Texture and More Textures to see these same options. 
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Lesson 7: Create a new presentation from an existing one  

Why would I want to do this? 

There are two main reasons: 

1.You may want to give a previous presentation again, but with changes, while keeping the 

original untouched. 

2.You may have created a presentation which uses the Company colours, has the logo on it etc 

etc.  The next time you create a presentation it would be nice not to have to do all that 

work again!  Creating a new presentation from an existing one allows you to use the 

existing layout in your new presentation.  In this case you would want to delete the 

original slides 

Creating the presentation 

Click  and   (or click  from the Quick Access toolbar) 

Click  

Find and click the required presentation and click .  

A new file is created, containing all the content from the existing file. 

Once you have made any necessary changes you can save the file, which will require a new name. 
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Lesson 8: Setting up Custom Shows 

What is this about? 

You may have a long presentation, say for a half hour talk, and then be asked to give a 10 minute 

talk on the same subject.  It is quite possible that you can use a selection of slides from the long talk 

to create the shorter talk.  Rather than create a new presentation you can create a Custom Show 

within the file for the larger talk, which selects those few slides, in the order you define.  You can 

then choose to show just the Custom Show.  You can create many different Custom Shows in one 

file – and you can connect them together using an index slide as will be demonstrated in Lesson 10: 

Creating a Custom Show 

Create all the necessary slides first. 

Click the Slide Show tab and click the Custom Slide Show icon (shown right) 

Click   and click   

Type a name for the Custom Show in the 

Slide show name box 

Click on each slide which you want in that 

particular show and click Add. (You can 

hold down the Ctrl key as you click to 

select several slides at once) 

The slides contained in the show will be 

listed in the box on the right.  

If you add a slide by mistake click on it in the box on the right and click Remove. 

Once all the required slides are shown click OK 

Note: Make sure that the slides are shown in the order in which you want them to appear.  If you 

have added them in the wrong order you can click a slide in the Slides in custom show box and 

click  to move it up the list or  to move it down 

Presenting a Custom Show 

There are two ways to view a Custom Show. 

Viewing a Custom Show quickly 

Click the Slide Show tab and click the Custom Slide Show icon and click the name of the Custom 

Show you want to see  

Setting a Custom Show as the default show 

To show a specific Custom Show by default when you click the  button or press F5 

Click the Slide Show tab and click the Set Up Show icon (shown right)  

In the Show slides section click Custom Show and select the name of the Custom Show 
 

Click OK 

After this every time you click  the defined Custom Show will 

be shown. 

Please note that if you want to view the whole slide show again 

you must return to Set up Show and select the   option  
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Lesson 9: Altering and Deleting Custom Shows 

Adding or removing slides from a Custom Show 

From the Slide Show ribbon, click Custom Slide Show, Custom Shows and click   

Adding  

Click on a slide in the left-hand box and click 

 

Note that the slides are always added at the end 

of the list.  

Removing 

Click on a slide in the right-hand box and click 

 

 

Changing the order of slides within a Custom Show 

From the Slide Show ribbon, click Custom Slide Show, Custom Shows and click   

In the right-hand box click the slide which you wish to move and click  to move it up or  to 

move it down. 

Changing the name of a Custom Show 

From the Slide Show ribbon, click Custom Slide Show, Custom Shows and click   

Edit the name in the Slide show name box, or simply type a new one 

Creating a new Custom Show based on an existing one 

If two Custom Shows are very similar it may be worth creating one, copying and then editing it. 

To make a copy of a Custom Show, from the Slide Show ribbon, click Custom Slide Show, 

Custom Shows and click   

The new Custom Show will automatically be called Copy of the old name. Edit the Custom show 

to add, remove slides and change the name 

Deleting a Custom Show 

We are talking about deleting, or removing the grouping of the slides, the Custom Show, only.  The 

slides themselves will not be deleted! 

From the Slide Show ribbon, click Custom Slide Show, Custom Shows, click the name of the 

Custom Show and click  and click  
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Lesson 10: Action settings 

What is this about? 

Suppose you regularly give presentations to prospective clients.  The company covers several 

different aspects of work, and has different locations.  Your presentations may cover a general 

introduction to the company, a review of facilities at the location the client is going to be associated 

with, and details of the particular work aspect in which the client is interested.  You could create a 

presentation for the general company introduction, one for each location, and one for each different 

aspect of work. Then create a presentation with one slide, with links to all the presentations, and 

click the particular links you need in the order you want to use them.  

You can also have many custom shows within one presentation, one for 

each subject, and then have an index slide with links to the custom 

shows, as shown right – where this links to Custom Shows set up for 

Accommodation, Gardens, Central Singapore etc. 

 Action settings enable you to define an action that will happen when you 

click a certain item on a slide, or maybe even when the mouse pointer 

moves over an item. 

E.g. when you click Accommodation the Accommodation Custom Show is shown and then the 

presentation returns to the index slide.  You could now click on China Town to see the China 

Town Custom show, and so on.  Thus you have the freedom to cover things in any order.  This type 

of action setting is called a Hyperlink 

Other action settings you can use are playing sounds and starting another application.  In this course 

we will cover Hyperlink and Sound actions.  These two actions are not mutually exclusive, i.e. you 

could jump to a Custom Show and play a sound at the same time. 

Setting up Hyperlink action settings 

Highlight the text, or picture, you wish to attach an action 

to. 

Click the Insert tab, then click the Action icon (shown 

right) 

 

Click the Hyperlink to option and click on the down 

arrow on the right  

You have many choices, which are detailed below.  Once you have selected the option click OK 

Next slide, Previous slide, First slide, Last slide, Last slide viewed:  these will all allow you to 

jump to the defined slide.   

End Show:  When you click the defined point the presentation will close. 

Custom Show, Slide, URL (a web location), Other PowerPoint presentation and Other File all 

require more information as detailed below: 
 

Custom Show 

If you click this option you will be required to select the 

required Custom Show.  

Before you click OK notice the  option at the 

bottom of the dialogue box.  This means that when the custom 

show ends you will return to the slide from which you started 

the custom show. 
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e.g. If you are coming from an index slide and wish to return to the index slide once the Custom 

Show is finished make sure you click to add a tick to this option.   

If the custom show is the end of the presentation then you can leave the option un-ticked. 

Slide 

You will be required to define the slide you wish to jump to.  

Note that the Slide show will then carry on showing the slides 

following the one you have jumped to. 

 

URL – Web Location 

You must type the relevant web location (e.g. 

www.bbc.co.uk) 

Note that your Internet Browser will be started and the 

address stated will be found – if you are connected! 

 

The PowerPoint Slide show will still be open and you can change back to view the slide you left at 

any time 

Other PowerPoint Presentation 

You will be required to select the required PowerPoint presentation.   

Note that once all the slides in the presentation have been shown you will automatically return to 

the slide in the original presentation from which you came 

Other File 

Again, you will be required to define the file.  This could be a Microsoft Word file, a Microsoft 

Excel file or any other file.  If it is a file from a recognised application that application will 

automatically be started.  You could also use a .exe file to start an application (e.g. winword.exe to 

start Word) 

Note that the PowerPoint Slide show will still be open and you can change back to view the slide 

you left at any time 

Setting up Sound Actions 

Highlight the text, or picture, you wish to attach an action to. 

Click the Insert tab, then click the Action icon  

Click to add a tick to Play sound.  Click on the 

down arrow to select a sound and click OK 
 

Make sure your speakers are plugged in, switched on and working! 
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Lesson 11: Adding Animation to text and objects 

Animation refers to the way that items on the slides can appear, disappear or move.  You can define 

animations for all or any items on your slide.  There are several different kinds of animation.  

Entrance defines when and how the item appears.    

Exit defines when and how an item disappears  

Emphasis  allows you to define a change that occurs when it is on the screen (e.g. text grows larger) 

Motion defines movement of an item on the slide. This is covered in Lesson 13:. 

Explanation of "Items" on a slide 

Looking at the slide on the right you can see there are 

various items.  You may think that there are 6 items, the 

heading Singapore Zoo – General, each bullet point, 

and the picture.  In a sense this is true, and each of those 

items can be brought onto the slide separately.   

However, the bullet points are all contained in one box 

(or place holder) so there are some complications in the 

way in which these are handled. 

In fact there are three items that you could animate: the 

title, the box of bullet points and the picture. 

Custom animation 

Click the  tab.  Click  and note the task pane that appears at the right 

of the screen. 

Click the item that you want to animate (the specific anomalies of bullets are covered in the next 

section) 

Click .   

You can now select Entrance, Emphasis or Exit and these are detailed below.  Note that you can 

have any or all of these animations on any one item. 

Click  to see a preview of the animations 

Entrance 

Initially there is a list of basic animations to choose from, as you use animations these will change 

to show the most recent used.Click the animation of your choice and watch the immediate preview 

to see if you are happy 

To select something a little more exciting click More Effects at the bottom of the list of animations 

to choose from 52 animations!  Click the animation you want to watch the preview (if you do not 

see a preview for More effects, click to add a tick to ).  Click OK once you are happy 

with your selected animation. 

The animation is now listed in the task pane.  E.g .  Note that there are 

several symbols here which tell you different things.  The 1 says that this is the first animation that 

will occur on the slide, the mouse indicates that the animation will occur when the mouse button 

is clicked, the green star  indicates it is an Entrance animation, Title 1 says that it is the first 

Title place holder on the slide, and finally you can see the beginning of the text. 
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Note that you will also see a number appear on the slide itself (in the above case the number 1) by 

the side of the item to indicate the order of animation.  This number will neither print nor show in 

the Slide Show. 

Emphasis 

There are several simple effects on which you can click.  Again, you can click More effects to find 

more. (if you do not see a preview for More effects, click to add a tick to ) The effects 

are very different from those under Entrance since with Emphasis the text is already on the slide.  

Thus the options are for increasing font size, brushing on colour etc. 

Emphasis animations are indicated in several ways, including yellow stars, yellow and blue stars, 

,  and .   

E.g .  This indicates that it is animation number 2 which will happen on a 

mouse click, it is an emphasis animation which changes the font size and affects the text contained 

in the first Title place holder. 

Again, a number representing the animation order will appear 

next to the item on the slide – so you can have more than one 

animation order number next to the same item. 

Exit 

Initially there are several basic animations to choose from, which will change to reflect recent 

animations used.  Click the animation of your choice and watch the immediate preview to see if you 

are happy 

Click  at the bottom of the list of animations to choose from 52 animations.  Click the 

animation you want and watch the preview (if you do not see a preview for More effects, click to 

add a tick to ).  Click OK once you are happy with your selected animation. 

The animation is now listed in the task pane.  E.g .  This is animation 

number 3 which will occur when the mouse button is clicked, the red star indicates it is an Exit 

animation, Title 1 says that it is the first Title place holder on the slide, and finally you can see the 

beginning of the text. 

The animation order number will again appear on the slide itself beside the item. 

Bullets and animations 

When your cursor is in a bullet point and you add an animation that animation will be added to all 

the bullet points in that place holder box.  However, each bullet point is given its own animation 

number. 

If you select a single bullet point and add an animation, the animation will be applied only to that 

bullet point. 

Animations involving bullet points are indicated in task pane by 

showing the first bullet point with a down arrow below it.  Click 

the down arrow to edit bullet points individually, changing the 

animation, or order etc as in the next lesson 
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Lesson 12: Manipulating Animations 

Change the animation used 

Make sure the Custom Animation task pane is showing (Animation tab, Custom Animation) 

In the task pane click the animation you want to change and click .   

Make the changes you require and click OK 

Note that when you click an animation in the task pane you will see, just below the buttons at the 

top of the task pane, something like  which reminds you what animation has been used. 

Change the sequence of animations 

Every time you add an animation it goes to the end of the sequence.  You may well wish to slot it in 

earlier.  You may wish a certain item (for example a picture) to appear when a particular bullet 

point appears.  To do this, animate the item and then expand the bullet points.  You can then follow 

the process explained below to move the item into the bulleted list, just below the particular bullet 

you wish it to follow. 

Make sure the Custom Animation task pane is showing (Animation tab, Custom Animation) 

In the task pane click the animation you want to move and use the  buttons at the 

bottom of the Custom Animation task pane.  Click  to move the item up one and  to move it 

down one. 

Remove an animation effect 

If you no longer wish to animate an item you can remove the animation – the item itself, of course, 

will remain on the slide. 

Make sure the Custom Animation task pane is showing (Animation tab, Custom Animation) 

In the task pane click the animation you want to move and click  at the top of the 

Custom Animation task pane. 

Selecting more than one animation at a time 

If you wish to move several animations to the same place, or you need to remove several 

animations you can make a selection of animations and then deal with them as a group. 

Neighbouring animations 

To select animations which are next to one another, click the first animation and then hold down the 

Shift key (on the keyboard) while you click on the last. This should select all the animations in 

between as well. 

Non- neighbouring animations 

If the animations are not next to one another click the first animation and then hold down the Ctrl 

key (on the keyboard) while you click the 2
nd

 and the 3
rd

 and so on. 
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Lesson 13: Motion paths  

What is a motion path? 

A motion path allows you to define movement of an item around the slide. 

Add a pre-set motion path 

Make sure the Custom Animation task pane is showing (Animation tab, Custom Animation) 

Click on the object which you wish to move.  

Click  and then click Motion paths.  Select one of the pre-set paths shown, or one 

from More Motion paths 

The object will follow the line shown on the slide (which will not be printed or be visible in a slide 

show) and will finish at the finishing point of the motion path. 

Draw a Custom Motion path 

Click  and then click Motion paths.  Select Draw Motion path and choose Line, 

Curve, Freeform or Scribble.  You must then draw the motion path on the slide.  How you do this 

varies with the option you chose – details are given below.   

The motion path will be shown as a dotted line with a green arrow at the start and a red arrow at the 

end.  Both arrows point in the direction the object will follow the path. 

In the Custom animation pane the motion path is shown with a symbol 

demonstrating the type of motion path (two examples shown right)  

Line 

Click and hold down the left mouse button at the point at which you want the motion to start.  Drag 

to the point at which you want the motion to stop and release the mouse button. 

Curve and Freeform 

Click and release the left mouse button at the point at which you want the motion to start.  Move the 

mouse pointer to the point at which you want to change the direction of the line and click again.  

Carry on clicking at every change of direction you want.  Double click the last point to finish the 

line.  The shape does not have to finish where it began. 

Curve creates a curve at every change of direction, while Freeform creates a sharp point at each 

change of direction. 

Scribble 

When you choose Scribble the cursor changes to a pencil .  Hold the left mouse button down and 

drag around the screen to draw the required shape.  Release the mouse button to finish the line. 

Change a motion path 

Changing the length or direction using handles 

Click to select the motion path and note that it has small white 

circles around it. (The white circles are called handles) 

Move the mouse pointer to one of the handles, click and hold the mouse button down 

and drag to lengthen or shorten the path. 

In the case of a line you can also drag to move the position of the end of the line. 
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Changing the shape of the line 

Where you have a Curve, Freeform or Scribble path (i.e. anything but a straight line!) you may need 

to adjust the shape of the path. 

Click the path to select it and then click with the right-hand mouse button 

(right click).  Select Edit Points.  A small black point will now be shown 

at each change of direction of the shape, and you can click and drag each 

of these points to a new position to change the line. 

Click on the back ground of the slide to move the selection away from the shape and finish editing.  

(Remember the Undo option if you have made a mess!) 

Motion path options 

When you right click on the path you will notice that there are two other options beside Edit 

Points.  These are explained below. 

Reverse Path 

The path will be altered so that the current start of the path becomes the new end.  i.e. the object 

will travel along the path in the reverse direction. 

Close path 

You may have drawn a path that ends at a different point from where it began. (as shown left).  If 

you select Close path the end of the path is joined to the start so that 

the object finishes where it began. (as shown right)  
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Lesson 14: Altering the way animations work:  Effect tab 

There are many ways in which you can adjust the animations and these depend on the animation 

type that you have chosen. Some of these adjustments are explained below.  To change animation 

options, first make sure the Custom animation task pane is visible. 

In the task pane click the animation you wish to alter.  Click the down arrow  to its right and click 

Effect Options and click on the Effects tab.   

Direction (for only Entrance and Exit) 

This is only available for Entrance and Exit animations on Title place holders, and on text place 

holders where all bullet points have the same animation. 

Click the down arrow beside Direction to select the direction from which the item will appear when 

it comes onto the slide, or in the case of Exit the direction in which it will disappear. 

Options available may be In, Out¸ Up, Down, Across, From Top, From Right, From Top Right 
etc, though which of these you see will depend on the particular animation you have selected, and 

some animations will not have the Direction option at all. 

In and Out mean that the shape of the text will build up from the outside or the inside respectively 

From Bottom, From Top, From Left, From Right all indicate that the text will travel across the 

slide in the direction indicated. 

Up and Across apply to situations where the letters appear gradually.   

Animating text (for only Entrance, Exit, Emphasis and Motion path) 

Normally the text will appear on the slide all at once but you can also choose to have it appearing 

by word (the first word appears, then the second and so on) or by letter (each letter will appear 

separately, rather as if the text is being typed)   

Note that you can also define the time between each word or letter appearing by changing the 

amount in .   This example means that when one letter is 10% of the 

way through its animation the next letter will begin its animation.  The larger the number the longer 

the total animation will take! 

Create a smooth start and/or finish (for only Entrance, Exit and Motion path) 

This is available on all Title place holders, but only on text place holders where all bullet points 

have the same animation and where the animation chosen is one which involves the text moving 

across the slide (e.g. fly where the text flies onto the slide to its position).  It stops the entrance or 

exit from beginning or ending with such sharpness.  

Auto reverse (for only some Emphasis and Motion path) 

You can use this to immediately reverse the emphasis you selected.  E.g. if you defined that the text 

should grow bigger and you use auto reverse then the text will grow bigger and then slowly 

decrease to its original size. 

Click the Auto reverse button to add a tick to remove the emphasis (or remove the tick if you wish 

the emphasis to remain in force) 

Sound (for only Entrance, Exit, Emphasis and Motion path) 

You can define a sound that will occur when the animation occurs.  This may be a feature which 

you will have to specifically install if you wish to use it. 
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Click the down arrow on the Sound option to select a sound from the list.  Click  to test the 

sound.  Click OK when you are happy. 

Path (for only Motion path) 

This option is shown at the top of the Custom Animation pane 

when you have clicked on a motion path animation. (as shown 

right) 

Locked:  If you move the object to which the path applies the path itself does not move at all.  

Unlocked:  When you move the object the path moves at the same time. 

Lesson 15: Altering the way animations work:  Text Animation tab 

In the task pane click the animation you wish to alter.  Click the down arrow  to its right and 

click Effect Options and click the Text Animations tab 

Grouping text – Bullet points (Entrance, Exit, Emphasis and Motion path) 

You can have more than one level of bullet point, as shown right.  If you 

choose to animate these the first point and all its sub points will appear at 
once.  To alter this: 

In the option  select the By 2nd level 
paragraph (or whatever is the lowest level you wish to use!) 

Click OK and each paragraph will then enter alone, without its sub points 

Animate Attached shape (Entrance, Exit, Emphasis and Motion path) 

This option will only be available for an item containing text (i.e. not a picture) which has a border 

or line showing around it, and behaves in a different way for Title place holders and for Bullet point 

place holders 

(To add a border, click the shape, click Drawing tools, Format and click on 

.Click  to use the colour shown, or click  to choose another 

colour) 

The way this behaves is explained below for Titles and Bullet points. 

Title place holders 

If the option has a tick  then the border is animated in the same way as the 

text inside the border.  To animate only the text within the border remove the tick. 

Bullet point place holders  

If the option has a tick  then the border is automatically treated as a separate 

item, is listed as a separate item and can have its own animation. 

Thus you could have the empty border appearing first followed by the text 

e.g.  and then  

In reverse order (Entrance, Exit, Emphasis and Motion path) 

Click this to make bullet items appear last one first! 
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Lesson 16: Altering the way animations work:  Timing tab 

The options covered in this section are all to do with 

setting the animations to run for a specific length of 

time, or to start at a certain time (relative to other 

events) and are available for all types of animations.  

Click the animation in the Custom animation pane and 

select Effect Options from the list.  Click the Timing 
tab 

Start 

Click the down arrow beside Start (You can also use 

the Start option at the top of the Custom Animation 

pane) 

On Click  

This is the default situation where the animation occurs when the mouse button is clicked (or the 

space bar is pressed) 

With Previous 

Sets this animation to start at the same time as the previous animation starts 

After Previous 

Allows you to set a time delay after the previous animation before this one occurs (see Delay) 

Delay 

This works in varying ways, depending on the setting for Start 

Start set to On Click 

If Delay is set to 0 then the animation will start immediately the mouse button is clicked.  If you 

wish there to be a pause after you click the mouse button and before the animation starts type a 

number representing the number of seconds for which you want the pause to last. 

Start set to After Previous 

If Delay is set to 0 then the animation will start immediately the previous animation has finished.  If 

you wish there to be a pause after the previous animation has finished and before the animation 

starts type a number representing the number of seconds for which you want the pause to last. 

Start set to With Previous 

The Delay option is ignored in this case since the animation starts immediately the previous 

animation starts 

Speed 

Click the down arrow beside Speed to choose the speed at which you would like the animation to 

occur. 

The speed given is the time it takes from the moment the animation starts to the moment it finishes. 
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Repeat 

You can select the number of times you wish the animation to repeat itself (2, 3, 4, 5 or10).  You 

can also choose to have it repeat, say, 6 times by typing 6 into the box. 

 

If you select Until next click the animation will continue occurring until the mouse is clicked again 

If you select Until End of Slide the animation will continue occurring all the time the slide is on 

screen. 

Rewind when done playing  

In the Effect Options dialogue box click the Timing tab and click the  

option. 

If this is ticked the text will return to its original state as soon as the animation has finished.  E.g. if 

you defined that the text should grow bigger and you use then the text will grow bigger and then 

immediately go back to its original size. 

This differs from Auto Reverse (on the Effect tab for emphasis) in that the return to its original 

size happens as a jump in size. 

Triggers 

A trigger is an animation option that can be set up so that the animation plays when a specified item 

is clicked 

Click  and options will open up as 

shown right.  You can then define what item you 

wish to click to start the animation 

This can be used for, say, a quiz.  If the right answer is clicked you can show a text box saying it is 

correct, if the wrong answer is shown you can show a text box saying it is incorrect 

e.g. 

We will use the slide shown right. 

Note that each answer is in its own text box, and we have a 

text box for the right answer, and another for the wrong 

answer. 

First, click the Well Done text box and set an entrance 

animation.  Then Right click the animation in the Custom 
animation pane, and click Timing. 

Click  and click Start effect on click of and 

select the Germany text box. 

The animation will now be shown as  
 

 

Now click the Sorry, you are wrong text box and set an entrance animation.  Go to Timing and 

click  and Start effect on click of and select the Pakistan text box. 

 

Repeat this for the other two wrong answers. 



PowerPoint 2007 Intermediate 

 22 

 

Lesson 17: Advanced Time Line 

To keep tabs on how long the slide show is taking, and for how long each slide, or each bullet point, 

is on screen you can use the Advanced time line. 

Switching the Advanced Time line on and off 

Start by making the Custom Animation pane wider (move the mouse pointer to the left border of 

the pane until you see the pointer change to  and drag to the left) 

In the Custom Animation pane click a down arrow to the right of any animation and select Show 
Advanced Timeline.  When the Advanced Time Line is showing this option will read Hide 

Advanced Timeline. 

At the bottom of the animation list area you will see a "ruler" appear marked in seconds 

 

In the animation list area, as you click each animation in the list you will see a shaded block  

These blocks represent the time the particular animation 

will take. 

In the example shown right the animation for Title 1 is a 

repeated animation, which is represented by the black 

lines within the block.  

If you rest your mouse pointer anywhere over the block a little yellow box will appear with details 

of the timing of the animation e.g.    

 

If the animations are all set as After previous then the 

shaded boxes will be shown as spread along the time 

line  

Changing animation times 

Start 

To delay the start of the animation, and make the animation last for a shorter time, move the mouse 

pointer to the start of the block, until you see the pointer change to  .  You can then drag the start 
to the right, while a small yellow box appears to tell you what the timing you are changing to is. 

If a delay exists before the start you will also be able to drag the start to the left so that the delay is 

less and the animation lasts longer.  You will not be able to drag the start earlier unless a delay 
exists and you can only drag it as far as the beginning of the delay. 

End 

To shorten or lengthen the time the animation takes to run move the cursor to the end of the block 

until the cursor changes to .  You can then drag to the left to shorten the animation running time, 
or to the right to lengthen the running time. 

Delays 

If you move over the block so that the mouse pointer changes to  you can drag the animation to 

the right without changing the amount of time it takes to run.  This will create a delay before the 

animation. 

If a delay already exists you can drag the animation to the left to decrease the delay period. 
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Lesson 18: Photo Albums 

What is a Photo Album? 

A photo album is a way of using a large group of pictures to create a presentation swiftly, without 

needing to customize each picture.   

Creating a simple Photo Album 

This will create a completely new presentation! 

Click the Insert tab and click the Photo Album icon shown right (if you click the arrow 

on the bottom you will need to click New Photo Album) 

Click  and change to view the correct drive and/or folder. 

Select all the pictures you require (use the Ctrl key while clicking pictures in order to select more 

than one) and click  

Click  

This gives a presentation with one picture per slide and no text. 

Adding a picture  

Click the Insert tab, click the lower part of the Photo Album icon (where the down arrow is)  and 

select Edit Photo Album 

Click on the picture after which you wish to insert the new picture 

Click , select the picture(s) and click  

The picture(s) will be after the selected picture.  See Moving pictures to alter their position. 

Deleting a picture 

On Insert, click the lower part of the Photo Album icon and select Edit 

Photo Album 

In the Pictures in album section in the centre of the dialogue box click 

on the specific picture(s) (use the Ctrl key to allow multiple selection) 

and click Remove 

Moving pictures  

On Insert, click the lower part of the Photo Album icon and select Edit 

Photo Album 

In the Pictures in album section in the centre of the dialogue box click 

on the specific picture and click  to move the picture up one position and  to move down one 

position. 
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Lesson 19: Altering the layout of Photo Albums 

Altering the number of pictures to a slide 

On Insert, click the lower part of the Photo Album icon and select Edit Photo Album 

Under the Album Layout section select Picture 

Layout  

You can now choose to select the following: 

Fit to slide 

This is the default, and will make the slide as big as possible on the slide, touching at least two 

edges.  It does not allow any text 

1, 2, or 4 pictures 

You can decide to have 1, 2 or 4 pictures per slide.  Remember that the more pictures on a slide the 

smaller they are.  This does not allow text as it stands, although you can use captions with this 

1, 2 or 4 pictures with Title 

Again, you can decide to have 1, 2 or 4 pictures per slide.  The pictures will be smaller than the 

equivalent choice in the previous option because a Title text box will be placed at the top of the 

slide so that you can add text into it. 

Adding captions 

On Insert, click the lower part of the Photo Album icon and select Edit Photo Album 

Check in the Album Layout section that Picture 
Layout is set to something other than Fit to slide. 

Under Picture Options (just above Album Layout) 

click to add a tick to   

When you return to view the slides you will see that each picture has a text box beneath it with the 

file name in.  This can be edited as desired. 

Adding/ Deleting text boxes 

To insert a text box into which you can type a larger amount than a Title box or a caption (e.g. 

bullet points), (These text boxes can also be used to space the pictures) 

On Insert, click the lower part of the Photo Album icon and select Edit Photo Album 

Click the picture after which you wish to insert the text box 

Click . 

The text box is shown in the Picture list as if it were a picture.  To delete it, click the text box and 

click .  You can also move it as if it were a picture. 
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Lesson 20: The PowerPoint viewer 

This is a facility that allows you to show a presentation even if the computer you are showing it on 

does not have Microsoft PowerPoint.  The necessary files come as standard with PowerPoint, and 

you will probably find it in c:\Program Files\Microsoft Office\Office 12.  It is called pptview.exe 

 

To use the viewer, find the 

pptview file and double click 

to run it  

Use the Look in box to find 

the file you wish to show and 

the click Open 

 

The presentation will 

immediately start in slide 

show mode.   

 

You cannot use the viewer to 

change the presentation in any 

way. 

The pptview file will easily fit onto a memory stick and is worth taking with you anywhere you take 

a presentation to show. 
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Lesson 21: Packaging a presentation to run on another computer 

This allows you to package a large presentation,(or linked presentations, or presentations using 

linked sounds etc)  in a way that will minimize the file size, and also ensure that linked files are not 

left behind.  It will include PowerPoint Viewer in the package in case the computer on which you 

hope to run the presentation does not have Microsoft PowerPoint, or does not have the correct 

version of PowerPoint. 

Note: You must have a CD writer in order to use this to copy to a CD, otherwise Copy to Folder .  

Warning: If you use this method to write to a CD-RW with existing content that existing content 

will be overwritten 

Packing the Presentation 

Select File, Package for CD  

Note that any files the presentation is linked to, and the 

PowerPoint viewer itself, will be included. 

 

 

 

 

To avoid including the Power Point viewer or any other files, click the Options button.  

You can also use this to define an order in which to 

play the presentations 

Select how presentations will show in the viewer 

By default, the CD is set up to play all presentations 

automatically in the order you specify (sometimes 

referred to as an Autorun CD), but you can change 

this default setting to automatically play only the 

first presentation, to automatically display a dialog 

box from which people can select the presentations 

they want to play, or to disable the automatic 

features and require people to manually start the CD 

Choose from one of the four options  

Linked Files 

These are files which the original presentation uses, such as where you have used action settings to 

jump to another file, or you have linked a video or sound 

Embedded True Type files 

True Type fonts vary with the operating system used on the PC.  If you are likely to show the 

presentation on a PC with a different operating system you should make sure that True Type fonts 

are embedded which means that they will be saved within the presentation (which will, of course, 

increase in size).  If you have bought extra True Type fonts it is possible these will not be 

embedded because of their copyright status. 

Help protect the PowerPoint files 

You can also add a password to prevent unauthorized access to your presentation 
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Lesson 22: Transferring information between PowerPoint and Word 

You may wish to use the PowerPoint presentation you have created as a basis for a report you will 

write in Word.  The Slide Titles will become first level headings; first level bullet points will 

become second level headings and so on. 

There are two ways of doing this 

Saving Presentation as an RTF file 

With the presentation open in PowerPoint, click , Save As 

In the Save As Type at the bottom of the dialogue box select the last option, Outline/RTF(*.rtf) 

Make sure you are happy with the file name (and note what it is!) and the location to which you are 

saving the file (and note where that is!!) click . 

You can now open Microsoft Word and select File, Open. 

In the Files of Type box at the bottom of the dialogue box select Rich Text Format (*.rtf)  

At the top of the dialogue box, under Look in choose the location in which the file was saved and 

then click on the file name. 

Click Open. 

You can now add text to the file, remember when you next save the Word document to select File, 

Save As and change the Files of Type box to Word document (*.doc) 

Sending a Presentation to Word 

You can choose to send the file directly to Word.  As well as the outline this option also gives the 

opportunity to send the slides and/or notes to Word – which means 

that you then have the power to alter the layout before printing. 

Click  , click and click Create Handouts in 

Microsoft Office Word. 

Choose what you want to send to Word 

Paste Link 

Note the Paste and Paste Link options at the bottom. 

If you are sending slides to Word and intend saving the file for 

future use you need to consider whether you wish the slides in the 

Word file to change if and when you make changes to the original 

slides in the PowerPoint presentation.  If you do wish them to 

update, click the Paste Link option. 

You cannot use Paste Link when you are sending the Outline only 

When you are happy with your choices click OK 

Microsoft Word will open with the information for which you asked in a document.  Remember to 

save the file as required.    

Notes next to slides and Blank lines next to slides will be converted to a table in Word. 

  


